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OVERVIEW 

Section 1-7-515, C.R.S., requires Colorado counties to conduct a new type of post-

election audit, called risk-limiting audits (or RLAs), beginning in 2017.  On August 

11, 2017, the Secretary of State adopted new Election Rule 25, specifying the 

manner in which random and risk-limiting post-election audits must be conducted 

in Colorado.  Rule 25.1 contains definitions generally applicable to risk-limiting 

audits.  Election Rule 25.2 prescribes the procedures for conducting risk-limiting 

audits. Election Rule 25.3 allows the Secretary of State to waive the RLA 

requirement and permit a county to conduct a random audit instead, and lays out 

the procedures for a random audit. Election Rule 25.4 addresses removal of audit 

board members.  

There are two types of RLAs: comparison audits and ballot-polling audits.  

Counties using vote tabulation systems capable of exporting ballot-level cast vote 

records (CVRs) – such as Dominion’s Democracy Suite® 5.11 and Clear Ballot’s 

ClearVote® 1.4.1 voting systems – must conduct comparison audits.  Counties 

using older voting systems that are not capable of exporting CVR data files must 

conduct ballot-polling audits, which are the least efficient type of RLA. 

This guide contains specific step-by-step instructions for county audit 

administrators and county audit boards to prepare for and conduct comparison 

audits, using the Dominion voting system and the Secretary of State’s RLA 

Software.1  

Note: Most of the pictures in this guide show examples from the 2017 Coordinated 

Election. Of course, when saving, naming or retrieving RLA-related folders and 

files, you should use the current election type and year (e.g. 2018 Primary, 2020 

General) instead.  

 

                                                
1 In the future, this guide may be updated to include step-by-step instructions for counties using 
the Clear Ballot system to export the data required for RLAs. Until then, Clear Ballot users should 
contact Voting.Systems@sos.state.co.us with any system-specific questions. 

mailto:Voting.Systems@sos.state.co.us
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If you have questions or encounter problems with any step in this guide, 

please contact the RLA team (Jessi Romero, Danny Casias, or Eddie Morgan) 

at 1-877-436-5677.  We will assist you over the phone, or remotely via GoTo 

Meeting. Some additional resources for counties to use for the RLA can be 

found on the CDOS FTP in the RLA/RLA_general information folder.  

 

ELECTION RECORDS 

Some documents used in and produced for a risk-limited audit are election records, 

and as such must be stored by the county for 25 months following the election. 

These documents, which are mentioned later in this guide, are: 

• The Ballot Manifest 

• The CVR (the original must be stored, any public release should be 

reviewed and redacted appropriately) 

• Final Reports produced by the RLA Software 

• Ballots 

Please reach out to the Secretary of State’s office if you have questions about 

records retention or redaction. 
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CHAPTER 1: RLA THUMB DRIVE 

Colorado Election Rule 20.5.3 requires that counties may only use thumb 

drives that are reformatted immediately before inserting them into a voting 

system. Due to this you should use a fresh—never been used before—

thumb drive to retrieve the required files from your voting system. In 

this section you’ll be able to do a few of the setup steps before inserting the 

thumb drive into the internet connect computer, the rest will be explained 

later in the guide.  

 

Step 1-A: Prepare Your RLA Thumb Drive 

1. Insert a thumb drive into the USB port of your EMS server or client. Open 
Window’s File Explorer by clicking on the icon that looks like a file folder in 
the left hand corner of the task bar at the bottom of your display. 
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2. In File Explorer, double-click the icon representing your RLA thumb drive.   

In the examples below, the thumb drive is named “CDOS,” and the 
operating system assigned drive letter (F:) to the thumb drive.  Your thumb 
drive will have a different name (often, the manufacturer’s name), and 
your operating system may assign your thumb drive a different drive letter. 

 

 

3. Right click on a blank area in the right hand pane of the File Explorer 
utility, and select New → Folder from the drop-down menu. 
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4. In the highlighted folder name field, name the folder RLA plus the election 
year and type (e.g. RLA2018 Primary), then press enter on your keyboard. 
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CHAPTER 2: EXPORT RLA DATA FROM DEMOCRACY SUITE® 

This chapter demonstrates how to print the reports and export the data 
files that you will need for the RLA from your Dominion EMS server or 

client. 

Step 2-A: Finish 9-day Tabulation and Adjudication 

Before printing the reports and exporting data that you will need for the RLA from 
your Dominion EMS server or client, make sure that you or your election judges 
(as applicable) finish the following tasks by the 9th day after Election Day, as 
required by Election Rule 25.2.2(f). 

1. Scanning all verified ballots (other than property owner and provisional 
ballots) received by the close of business on the 8th day after Election 
Day. 

2. Adjudicating all blank ballots and ballots with overvotes, write-in votes and 
ambiguous markings, that queued or presented for human adjudication in 
the adjudication application. 

3. Validating and publishing all results in the Results, Tally and Reporting 
(RTR) application. 

Step 2-B: Export the CVR File 

With the RLA thumb drive in the USB port of your Dominion EMS server or client. 
 

1. On your Dominion EMS client or server, open the Results, Tally and 
Reporting (RTR) application. 

2. Navigate to the Actions menu, click the Export menu item, and then click 
the CVR Export sub-menu item. 
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a. The CVR Export screen will appear.  

 

 

i. Leave the filters with drop-down menus if the top five fields set to 
All 

ii. Place a check mark in Published batches only and Use tabular 
format boxes (VERY IMPORTANT!) 

iii. Click Export 

iv. An Info dialog box will appear and indicate where your file is 
saved. 

 

v. Take note of this file path (we suggest taking a picture of the file 
path with your phone, or writing it down on a piece of paper and 
keeping it handy.  
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vi.  Go back to CVR file path Info screen in RTR.  Once you have 
noted the location of the CVR file, click Close.  

 

 

vii. Navigate to the location of the CVR file you just noted and copy 
the CVR export file from your Dominion EMS client or server to 
the folder for the current election on your RLA thumb drive.  

IMPORTANT:  Copy the CVR export file from its location on the 
Dominion EMS server or client to your RLA thumb drive by using 
the copy and paste commands (Ctrl-C to copy, Ctrl-V to paste), 
but do not open the CVR in Excel by double-clicking the file and 
then “saving as” to the RLA thumb drive. If you do that, Excel will 
convert any entry in the ImprintedID field that looks like a date to 
Excel’s date format.  For example, Excel may convert ImprintedID 
“12-6-37” to “6-Dec 1937.” That automatic reformatting may make 
it difficult for your audit board to locate and retrieve randomly 
selected ballots during the RLA.  We will provide instructions on 
how to import the CVR file into Excel and retain the original 
formatting in a later step.  For now, just copy the file to your RLA 
thumb drive, and don’t double-click or open it. 
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Step 2-C: Export the ENR Results File  

You will need an ENR results file that matches the results reflected in the CVR 
file. Export the file now, while you are working on the Dominion server or client. 

 
1. Log into RTR.  From the top left, select Start Results Export 

 

2. When the export is complete, a confirmation message will display in the 
lower left hand corner.  

 

3. The report will be saved in the location set in your Transfer Points 

4. Copy the ENR results report to the folder for the current election on your 
RLA thumb drive. 
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Step 2-D: Safely Eject the RLA Thumb Drive 

Simply removing a thumb drive from the USB port of a computer workstation can 
corrupt the data saved on the thumb drive.  To avoid that risk, follow these steps 
to use Windows’ “Eject” function anytime you want to remove a thumb drive. 

1. In the right hand corner of the bottom task bar on your Windows desktop, 
click the “show hidden icons” upward arrow, and then click the thumb drive 
icon in the pop up menu. 

 

 

 

2. In the pop up menu, select the option to eject your thumb drive.  In the 
example below, the proper selection is “Eject CDOS (F:)”  Your RLA 
thumb drive will probably have a different name and drive letter. 

 

 

 



RLA Software Complete Reference Guide 

 

Version 3.2.1  
Last modified 9.22.2020   Page 14 of 71 

3. You will receive a message like this when Windows ejects your RLA 
thumb drive and it is safe to remove from the USB port of the computer 
you’re using. 
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CHAPTER 3: FINISH PREPARING FOR THE RLA 

Now that you’ve finished getting all of the required files from the voting 
system you can put the rest of the files needed for the RLA onto the thumb 
drive. Remember, once you’ve connected the thumb drive to an internet 
exposed computer, you cannot connect that thumb drive back to the voting 
system. If you need to get the voting system files again, use a new thumb 
drive. 

Step 3-A: Install the Chrome Web Browser on your RLA 

Workstation 

The Secretary of State’s RLA Software works best with Google’s Chrome web 

browser.  If you have not done so already, you can download and install the web 

browser from the internet for free. 

1. Open your current web browser, and go to 
https://www.google.com/chrome/ . 

2. Click the button that says DOWNLOAD CHROME, and follow the step-by-
step online instructions. 

Step 3-B: Download RLA Files and Utilities from CDOS FTP Site 

1. Log into the CDOS FTP site from your RLA workstation.  Using your web 
browser, go to https://ftps.sos.state.co.us/webclient/Login.xhtml, and enter 
your user name and password. 

 

If you need help logging into the CDOS FTP site, contact SCORE Customer 
Support at SCORE.CustomerSupport@sos.state.co.us 

https://www.google.com/chrome/
https://ftps.sos.state.co.us/webclient/Login.xhtml
mailto:SCORE.CustomerSupport@sos.state.co.us
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2. Navigate to and click on the RLA subfolder of your county folder on the 
FTP site. 

 

 

 

3. Click on the RLA_general subfolder to reveal its contents and click on the 
RLA_general information folder. 
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4. Use your mouse to check the boxes to the left of the two files listed below. 
Then click the Download button in the lower left corner of your browser. 
 

• Hash Values.doc 

• QuickHash-Windows-v 2.8.0.zip  

 

 

5. Click the compressed file that appears beneath the Download button and 
above the Windows task bar to reveal the four individual files that you 
downloaded. 
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6. Windows opens a folder in the Compressed Folder Tools utility.  Use your 
mouse to select all four files, right click your mouse button, then select 
Copy from the drop-down menu. 

 

7. Navigate to the folder for the current election on your RLA thumb drive. 
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8. Use your mouse to click into the right hand pane of that window, right click 
your mouse button, then select Paste from the drop down menu. 

 

 

9. You have downloaded to the folder for the current election on your RLA 
thumb drive all of the files you need from the CDOS FTP site.  You may 
now log out of the CDOS FTP site by clicking the Logout button in the top 
right corner of Chrome, or by just closing the browser. 

 

  

  



RLA Software Complete Reference Guide 

 

Version 3.2.1  
Last modified 9.22.2020   Page 20 of 71 

  



RLA Software Complete Reference Guide 

 

Version 3.2.1  
Last modified 9.22.2020   Page 21 of 71 

CHAPTER 4:  FORMAT THE BALLOT MANIFEST 

You should have started maintaining a ballot manifest at the time you started 
counting ballots, as required by Rule 25.2.2(c). The screen shot below 
shows a sample ballot manifest, and includes some important pointers to 
ensure your ballot manifest can be uploaded into the RLA Software.  The 
pointers are discussed in more detail immediately following the screen shot. 

 

List is sorted 
by Tabulator 
ID, then 

Batch ID 
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Step 4-A: Formatting the Ballot Manifest 

1. Column A – County: Enter the name of your county, but don’t add a 
space before or after the name, or the word “County”.  So Arapahoe 
County should be entered simply as Arapahoe. 

2. Column B – Tabulator ID: Only use numbers in this column – no letters, 
spaces or other characters. Make sure that the Tabulator ID used in the 
ballot manifest matches the tabulator number in your CVR. 

3. Column C – Batch:  Again, only use numbers in this column. 

4. First Row – Headers:  Do not change the pre-formatted header fields, or 
add additional header rows. 

5. Last Row:  Make sure that the final row of your ballot manifest is fully 
populated in Columns A to E.  If you have extra rows populated with only 
the county name, delete them. 

Step 4-B: Sorting the Ballot Manifest 

Before uploading to the RLA Software, you should sort the ballot manifest in 

ascending order by Tabulator ID, then by Batch. Here’s one way to do that.  

1. In this example ballot manifest, the Tabulator IDs and Batch numbers 
appear in random order (this could occur if separate manifests from 
different tabulators are consolidated into one ballot manifest).  
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2. Select the entire sheet by clicking the diagonal arrow immediately above 
row 1 and to the left of column A. 

 

3. Select the Data tab at the top, then the Sort icon.  
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4. In the Sort dialog box, click on the down arrow in the Column – Sort by 
field, then select Tabulator ID from the down menu.  

  

5. Click the Add Level button at the top, click on the down arrow across from 
Then by, select Batch from the drop-down menu. Then click OK.  
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6. Your ballot manifest is now sorted in ascending order by Tabulator ID and 
Batch. Remember to save the file in CSV format. 

 

7. Since you changed the sort order, you need to save the ballot manifest to 
your RLA thumb drive to maintain the proper ascending order. Excel 
displays the following (annoying) message every time you try to save a 
CSV file.  Unless this guide specifically directs otherwise, you should 
always select Yes when you see this message.  That is because the RLA 
Software will not permit you to upload data files unless they are in CSV 
format. 
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CHAPTER 5: IMPORT AND MODIFY THE CVR FILE 

This chapter explains how to import into Excel the original CVR file that 
you exported from DemocracySuite® in a way that prevents the automatic 
conversion of ImprintedID values into dates.  This chapter also explains 
how to skip importing the CountingGroup column into the CVR file that 
you will upload to the RLA Software.2   

Step 5-A: Open Excel 

1. Open the Excel program from your computer’s start menu.   

2. Remember: In this case, don’t open Excel by double-clicking the CVR file. 

Step 5-B: Open Excel’s Text Import Wizard 

1. Select the Data tab, then From Text. (For Excel 2019 see below) 

 

For Excel 2019 instead go to the Tell me what you want to do tab and type 

From Text (Legacy), then select the option of the same name to use the legacy 

import data wizard.  

 

                                                
2 Condition CVR-1 in the Dominion Conditions of Use requires counties to delete the 
CountingGroup column from the CVR export before hashing and uploading the file to the RLA 
Software.  Not importing the CountingGroup column into the CVR file that you will upload in the 
first place is one way of complying with Condition CVR-1.  
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2. The Import Text File dialog box appears.  Browse to the folder for the 
current election on your RLA thumb drive; select the CVR file you 
exported from the Dominion system, and click Import. 

 

Step 5-C: Specify Data Formats and Rules 

1. The Text Import Wizard – Step 1 of 3 dialog box appears.  Make sure 
that the radio button for Delimited is selected, check the box next to My 
data has headers., and click the Next button. 
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2. The Text Import Wizard – Step 2 of 3 dialog box appears. Check the box 
next to Comma, and select Next 
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3. The Text Import Wizard – Step 3 of 3 dialog box appears.   

a. Instruct Excel to import ImprintedID values as text   

In the Data preview section at the bottom of this dialog box, select the 
5th column from the left (the column that contains the ImprintedID 
header) by clicking anywhere in that column with your mouse pointer, 
and then click the button next to Text in the Column data format 
section at the top of the dialog box. 

 

Do not click Finish yet.  You need to do one more thing in this Text 
import Wizard - Step 3 of 3 dialog box. 
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b.  Instruct Excel not to import (or to skip) the CountingGroup column.  

To perform this step, you may need to use the horizontal scroll arrows 
beneath the Data preview section to reveal the 6th column of the CVR 
file that contains the CountingGroup header.  

Select the CountingGroup column by clicking anywhere in the column 
with your mouse pointer.  Then click the radio button next to Do not 
import column (skip) from the Column data format selections and 
click Finish. 
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3. The Import Data dialog box appears. You should not have to change 
anything here.  Just make sure that the button next to Existing 
worksheet is selected, and that the field immediately beneath Existing 
worksheet is populated with =$A$1 (the cell where the data wizard will 
import the designated data from the CVR file into this new Excel 
workbook) and click OK. 

 

4. You have successfully imported the raw CVR file into a new Excel 
workbook.  Note that the values in the ImprintedID column have not been 
converted into dates (but now have equal signs and quotation marks), and 
that the CountingGroup column was not included when the other CVR 
data was imported. 
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Step 5-D: Save Modified CVR Data as New CSV File  

Now save this new Excel file in .CSV format and use a different file name to 
clearly indicate that it is a modified version of the CVR file originally exported 
from DemocracySuite. 

1. Select File → Save As from the drop-down menu in Excel’s ribbon, and 
browse to the folder for the current election on your RLA thumb drive. 

2. From the Save as type: drop-down menu towards the bottom of the Save 
As dialog box, select CSV (Comma delimited) (*.csv). 

3. After you’ve selected CSV format, you should be able to see the original 
CVR file exported from DemocracySuite.  Single click the original CVR file, 
which will cause its name to display in the File name field of the Save As 
dialog box. 

4. Click into the File name field of the Save As dialog box (not the file name 
of the original CVR file), and add “Modified_” to the beginning of the new 
file name, then click Save.   

  

5. You will see the following message again about saving the file in CSV 
format.  Click Yes.  
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CHAPTER 6:  VERIFYING THE BALLOT MANIFEST AND CVR 

In the chapters above, you verified that your ballot manifest is correctly 
formatted and sorted, and you created a modified version of your CVR file 
that contains the correct ImprintedID values, and does not include the 
CountingGroup column as required by the Conditions of Use.  This chapter 
explains how to verify that your ballot manifest reflects the same number of 
ballot cards as the CVR file.  This step is important because, if there is a 
mismatch between those two files the RLA Software may randomly select 
ballots for your audit board to examine that either do not exist or are out of 
order. A selection of a ballot that does not exist in the CVR results in a 
phantom ballot, which the RLA Software will automatically count as a 
discrepancy. If this happens, the result could be that you have to complete a 
second round of auditing, even if your audit boards make all of the correct 
selections on the ballots that are presented to them. 

Step 6-A: Determine Number of Ballot Cards in Ballot Manifest 

1. Open the ballot manifest saved on your RLA thumb drive. 

2. Highlight all of the cells in column D by left clicking the column header. The 
number of all ballot cards in all batches in the ballot manifest appears as the 
Sum in the lower right-hand corner of the window. (Note: In different versions of 
Excel this number might appear in a slightly different place, but it is in the same 
general area.) 

Write this number down so you can compare it to the CVR in the next step. 

3. Close the Ballot Manifest 
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Step 6-B:   Determine Total Number of Ballot Cards in CVR File 

1. From your RLA thumb drive, double-click the modified version of your 
CVR file 

 

2. Click into any cell in column A and press Ctrl- (down arrow) on your 
keyboard to go to the final row containing data in column A. 

 

3. In this example, the last unique CVR number is 152, meaning that the 
CVR file contains a total of 152 ballot cards.  You have successfully 
verified the ballot manifest and CVR files, because the number of ballot 
cards in the CVR file matches the number of ballot cards reflected in the 
ballot manifest.  You can close the CVR file – you have not modified it in 
any way in this chapter, so there is no new data to save. 
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CHAPTER 7: HASH THE BALLOT MANIFEST AND MODIFIED 

CVR FILE 

IMPORTANT: Please be sure to follow these steps exactly in the order they are 
presented. If the order is not followed there may be a discrepancy with your hash 
value.  

Step 7-A:  Launch and Configure the QuickHash Utility 

1. You downloaded a compressed (.zip) file containing the QuickHash utility 
to your RLA thumb drive from the CDOS FTP site in Step 3-B. 

 

2. Double-click the .zip folder to reveal its contents, and then launch (double-
click) QuickHash_Windows-v2.8.0-32Bit.exe. 
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3. Select the File tab. 

 

 

 

4. Under the Algorithm heading, select the radio button next to SHA256. 

 
 
 

Step 7-B:  Hash the Ballot Manifest and Save the Hash Value 

1. Click on Select File. 

 



RLA Software Complete Reference Guide 

 

Version 3.2.1  
Last modified 9.22.2020   Page 39 of 71 

2. In the Open existing file dialog box, browse to your RLA thumb drive, 
select the original ballot manifest in CSV format, and click Open. 

 

 

3. When you open the original ballot manifest with QuickHash, the utility 
automatically examines the file and returns a hash value in the second 
field under the Single File Hashing heading. 

 

4. Double-click on the hash value, to select the entire string. 
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5. Right click your mouse, and select Copy from the drop down menu. 

 

 

6. If it is not already open, browse to your RLA thumb drive and double-click 
the Word document called Hash Values.doc.  In that document, use your 
mouse to click beneath the Ballot manifest hash value heading, and 
press Ctrl-V on your keyboard to paste the ballot manifest’s hash value 
from the QuickHash utility to the appropriate location of the Hash Values 
document.  

7. Save (Ctrl-S) the Hash Values document.  You will use that document to 
copy the ballot manifest’s hash value into the RLA Software when you 
upload the ballot manifest. 
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Step 7-C:  Hash the CVR File and Save the Hash Value 

1. Return to the QuickHash utility, click Select File on the File tab. 

  

2. Browse to your RLA thumb drive, select the modified CVR file, and click 
Open. 

 

3. If the following error occurs, it means the file is open. Close the file 
then proceed to step 4.  
 

 



RLA Software Complete Reference Guide 

 

Version 3.2.1  
Last modified 9.22.2020   Page 42 of 71 

4. Double-click the CVR’s hash value to select the entire string, right click 
your mouse, then select Copy from the drop-down menu. 

 

5. Open (or go back to) the Word document called Hash Values.doc, click 
beneath the CVR export hash value heading, and enter Ctrl-V from your 
keyboard to paste the CVR’s hash value from QuickHash to the Word 
document.  

 

6. Save (Ctrl-S) the Hash Values document.  You will use that document to 
copy the CVR file’s hash value into the RLA Software when you upload 
the modified CVR file. 
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CHAPTER 8: UPLOAD RLA FILES TO CDOS FTP SITE 

Before you log in or upload files to the RLA Software, please first upload to 
the CDOS FTP site the 1) completed Hash Values document, 2) hashed 
ballot manifest and 3) hashed modified CVR file.  

Step 8-A: Log in to CDOS FTP Site 

1. See Chapter 1, Step 3-B, for instructions on how to log into the CDOS 
FTP site. 

Step 8-B: Navigate to RLA_current election subfolder 

1. Navigate to and click the RLA_current election folder in the RLA 
subfolder of your county folder. 

 

 

 

 

2. Click the Upload button.  
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3. When the Open dialog box appears, browse or navigate to the folder for 
the current election on your RLA thumb drive, select the following three 
files while holding the Ctrl key on your keyboard, then click Open. 

• The ballot manifest in CSV format (not the verified version containing 
the formula in XLS or XLSX format) 

• The Hash Values.doc file, containing the name of your county, the 
path of your original CVR export, and the hash values for your ballot 
manifest and modified CVR file 

• The Modified_CVR_Export.csv file in CSV format (not the version of 
that file originally exported from the Dominion system) 

 

4. The RLA_current election folder now contains the three individual files, 
and the status message shows you the upload was completed 
successfully. 

 
5.  Log out of the CDOS FTP site. 
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CHAPTER 9: UPLOAD FILES TO THE RLA SOFTWARE 

Each county must designate at least one person to act as the county audit 

administrator.  The county audit administrator is responsible for uploading 

the county’s ballot manifest and modified CVR file to the RLA Software, 

and launching the audit sessions during which the county’s bipartisan audit 

boards examine and report voter markings from randomly selected paper 

ballots.  The county audit administrator must have SCORE user 

credentials. 

Step 9-A: Insert RLA Thumb Drive in RLA Workstation 

1. Insert your RLA thumb drive into a USB port of your internet-connected 
RLA workstation. 

2. Navigate to the folder for the current election on your RLA thumb drive, 
and open Hash Values.doc.  You will copy hash values from that 
document and paste them into the RLA Software during the uploading 
process. 

Step 9-B: Log into RLA Software and Upload RLA Data 

1. Open Chrome and open an incognito window by entering Ctrl+Shift+N 
after you’ve started Chrome.  
 

2. In the new incognito window, navigate to the RLA Software at 
https://rla.sos.colorado.gov/login. 
 

3. At the CORLA User Login screen, the county audit administrator enters 
his or her SCORE username and password. 

 

https://rla.sos.colorado.gov/login
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4. Enter the responses to the grid challenges from your Entrust grid card and 

click on Submit. 

 

Step 9-C: Upload Hashed Ballot Manifest 

1. Once you are logged into the RLA Software, select the Browse button to 
the right of the Ballot Manifest file field:. 
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2. When the Open dialog box appears, browse to and select the ballot 
manifest file in CSV format in the folder for the current election of your 
RLA thumb drive, then click Open:. 

 

 

3. Go to the Hash Values.doc document, select the complete hash value 
string for the ballot manifest, right click your mouse, and select Copy from 
the drop-down menu.  
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4. Go back to the Chrome web browser and click into the SHA-256 hash for 
Ballot Manifest field of the RLA Software. 
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5. Right click your mouse, and select Paste from the drop-down menu. 

 

6. The ballot manifest hash value now appears in the proper field.  Click the 
Upload button. 
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7. You will see these messages when you successfully upload the hashed 
ballot manifest. 

 

 

Step 8-D: Upload Hashed CVR File 

1. Click the Browse button next to the right of the CVR Export field. 
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2. When the Open dialog box appears, browse to and select the modified 
CVR file in the folder for the current election of your RLA thumb drive, then 
click Open. 

 

3. Go to the Hash Values.doc document, select the complete hash value 
string for the modified CVR file, right click your mouse, and select Copy 
from the drop-down menu. 
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4. Go back to the Chrome web browser and click into the SHA-256 hash for 
CVR Export field of the RLA Software. 

 

5. Right click your mouse, and select Paste from the drop down menu. 

 

6. The hash value for the modified cast vote record file now appears in the 
proper field.  Click the Upload button. 
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7. You will see these messages when you successfully upload the hashed 
modified cast vote record file (it may take a little while to upload the CVR). 

 

Step 9-E: Log Out of RLA Software and Wait for State to Start 

Audit 

1. You have uploaded all of the data for your county that the Secretary of 
State’s office requires.  Log out of the RLA Software by closing your 
browser, and wait for the state to start the risk-limiting audit for all counties 
the morning after the deadline for completing the uploading process. 
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CHAPTER 10: DOWNLOAD THE BALLOT LIST 

Step 10: Download Ballot List 

 

1. When the Secretary of State’s office notifies you that the risk-limiting audit 
has been defined and started at the state level, the county audit 
administrator must log into the RLA Software.  See Chapter 9, Step 9-B 
for RLA Software log in instructions. 
 

2. Before your audit board arrives or convenes, download the list of ballots to 
audit by clicking on the Download button under the heading Intermediate 
audit report (CSV). When the file is done downloading, you can open it 
by clicking on the icon in the lower left corner of your browser. 
Alternatively, you can skip to step 5 in this list to download the list by audit 
board and organized by storage location after the number of audit boards 
have been selected. 
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3. The intermediate audit report will open in Excel. To see the ballot list click 
on the Round 1 tab at the bottom of the worksheet.  
 

 

 
4. You can use the list of ballots to organize ballot containers and other 

materials so things go smoothly and quickly when the audit boards begin 
their work.  But it’s important to note that county elections staff may not 
open the sealed ballot containers or retrieve any individual ballots unless 
the audit board members are present. 
 

5. If you would like to organize ballots by audit board team you can use the List of 
ballots to audit (CSV) after first selecting the number of audit boards you are 
going to use in that audit round. 
 

 



RLA Software Complete Reference Guide 

 

Version 3.2.1  
Last modified 9.22.2020   Page 57 of 71 

CHAPTER 11:  AUDIT BOARDS SIGN IN AND CONDUCTS FIRST 

AUDIT ROUND 

 

Step 11-A: Sign in Audit Boards 

1. When the audit boards arrive, the county audit administrator must log into 
the RLA Software. See Chapter 9, Step 9-B for RLA Software log in 
instructions. 
 

2. Select the number of audit boards you would like to use for this round and 
click the Enter button. It may take a second to load the audit boards.  
 
Keep in mind that the number of audit boards cannot be changed once 
you’ve selected the number you’d like to use within a round, but in 
subsequent rounds you can use greater or fewer boards than you’d 
previously used. 
 

 

 
 



RLA Software Complete Reference Guide 

 

Version 3.2.1  
Last modified 9.22.2020   Page 58 of 71 

a. At this point you may also download the list of ballots to be audited 
by clicking the button below the List of Ballots to Audit (CSV) 
heading. The button will not be grayed out once you have selected 
the number of audit boards you will use in the round. (Also 
mentioned in Chapter 10, Step 10-5.) 

 
3. To proceed to sign in an audit board, click the button for the audit board 

number you would like to sign in. Orange buttons already have audit board 
members signed into that audit board.  

 
 

You should repeat steps 4 to 7 for each audit board.  

4. Enter the names and party affiliations of both of your county audit board 
members.  Each member must have a different party affiliation.  Then click 
Sign In. 
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5. The Ballot Cards to Audit screen will display. This screen lists each 
ballot that was randomly selected for the audit. Click on the Start audit 
button when the ballots have been retrieved and your audit board is ready 
to start reporting voter markings from the paper ballots.3 

 

You will notice that the ballots are sorted by storage location, and on the far right 
the software notes which audit board each ballot was assigned to. 

  

                                                
3 At this point you may download the list of ballots to be audited if you did not do so before or 
would like to for whatever reason by clicking on the Download ballot list as CSV button.  
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Step 11-B: Ballot Card Verification 

1. Each county audit board now begins the audit in earnest by reporting the 
voter markings they observe on each randomly selected paper ballot into 
the RLA Software.   

2. Each page of an audit board’s user interface corresponds to the next 
ballot card listed in that audit board’s ballot list, starting with the first.  The 
top of each screen identifies the audit board working on that ballot and the 
audit board’s progress through their list. On the left side, the ballot 
identification information can be found. The audit board should confirm all 
of this information, especially that the ballot type matches the ballot type in 
the header of the ballot, before begin making choice for each ballot.4 If the 
wrong ballot’s marking are entered into the RLA Software, it may result in 
discrepancies sending your county, or perhaps even the whole state, to 
another audit round.  

 

If your audit board cannot find the correct ballot they should select the red 
button that says Ballot not found – move to next ballot. This should be 
used only as a last resort. Selecting this button will result in discrepancies 
for all contests on the ballot and vastly increase the likelihood of another 
audit round.  

                                                
4 Some counties use ballot images obtained from the voting system to ensure the ballot they 
retrieved is the ballot that is being presented by the software. For instructions on how to obtain 
ballot images, see Appendix I. Remember, under no circumstances should the audit board use 
the ballot images for entering voter choices into the software. That must always be done from the 
original ballot submitted by the voter.    
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As the audit board moves down each page, it should find the same contests and 
choices as the corresponding paper ballot.  If that is not the case, the audit board 
should stop immediately and try to determine if the right ballot was located.  
 
 

Step 11-C: Reporting Voter Markings 

1. The audit board must replicate the voter markings from the paper ballot in 
the RLA Software by selecting the box that contains the candidate or 
choice the voter made on their ballot. At the top of the selection part of the 
ballot screen there are some basic instructions to help remind audit 
boards of these instructions. 

 

2. Below the instructions the audit board will find each contest as it appears 
on that particular ballot along with all candidates or choices for that 
contest, including certified write-in candidates. 
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Once an audit board makes a selection the box(es) they’ve selected will 
be highlighted in blue. 

 

To deselect a choice, the box should simply be clicked again.  

3. Sometimes voters make more than one mark, or make too few or no 
marks, or do other things that are hard to understand. Audit boards can be 
can be confused about these situations. To help reduce confusion in 
commonly encountered abnormalities there is a mini-FAQ that scrolls with 
the audit board on the left side of the ballot screen. If the board 
encounters any of these situations they can click the appropriate issue 
and the software will provide guidance.  
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4. Some of the commonly encountered questions the audit board members 
may have are discussed below. If there is any question about voter intent, 
please consult the Secretary of State’s office’s Voter Intent Guide.  

a. Overvote: If the voter marked too many choices (or in cases when 
the voter appropriately marked more than once choice) the same 
choices should be selected in the RLA Software.  

 

b. Undervote or blank vote: The most common type of undervote is a 
contest that the voter decided to skip—made no mark. The audit 
board should select the Blank vote – no mark button.  

 

Like an overvote, if the contests allows the voter to choose more 
than one candidate, but decides to make fewer than that, the audit 
board should reflect the choices the voter made exactly.  
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c. Sometimes audit board members may not agree on what the voter 
intent was. In these situations, the audit board members should 
consult the Voter Intent Guide and try to come to a consensus. If 
they cannot, the audit board members should mark the No audit 
board consensus button. However, this selection will result in a 
discrepancy being reported, which may cause your county or the 
entire state to audit more ballots. The RLA Software will produce a 
warning for the audit board if they select this button. 

 

d. Write-in candidates: 

• If the paper ballot contains a write-in vote for a certified write-in 
candidate, the audit board should select that candidate in the 
RLA Software. (All certified write-in candidates appear as 
selections in the software.) 

• If the paper ballot contains a write-in vote for a named 
candidate, the audit board should select the named candidate in 
the RLA Software. 

• If the paper ballot contains a write-in vote for an unqualified 
write-in candidate, the audit board should select Blank vote – 
no mark in the RLA Software. 
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e.  Withdrawn candidates and contests: 

• If the withdrawn candidate or contest appears as a choice for a 
particular ballot in the RLA Software, the audit board should 
faithfully replicate any and all votes for the withdrawn candidate 
or in the withdrawn contest. 

• If the withdrawn candidate or contest does not appear as a 
selectable choice in the RLA Software version of the ballot, the 
audit board should select Blank vote – no mark. 

Step 11-D: Reviewing Voter Markings 

1. After entering the voter markings for every contest on the ballot, click the 
Review button at the bottom of the page. 

 

2. On the review screen, the audit board should confirm that the information 
displayed accurately reflects its interpretation for each contest and choice 
from the corresponding paper ballot. 

3. If there are any discrepancies, the audit board should click the Edit button 
next to the contest that has a discrepancy, and reenter the voter markings 
for the contest.  If the review page accurately reflects the audit board’s 
interpretation of all votes in all contests, the audit board should click the 
Submit & Next Ballot Card button at the bottom of the page. 

 

4. Repeat Steps 11-C and 11-D for every ballot listed on your county’s ballot 
list. 
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Step 11-E: Re-audit 

1. Once the audit board replicates and submits the voter markings from all ballots, 
the audit board is given the opportunity to re-audit individual ballots they think 
they may not have inputted the correct markings. If the audit board wishes to re-
audit the ballot they will have to give a reason why they are choosing to re-audit 
the ballot and then are presented with the races from that particular ballot again. 
When the audit board decides to re-audit a ballot, all markings from the previous 
times the ballot was presented will be deleted before the ballot is presented 
again.  

 
2. For each ballot the audit board wishes to re-audit, the audit board should find the 

ballot from the list that is presented (sorted first by storage bin, then scanner, 
batch, and finally ballot position), then click the Re-audit button.  
 

3. The audit board should then retrieve the paper ballot to re-audit and faithfully 
replicate the markings that the voter made on their ballot. (Go back to Step 11-
C). Once the audit board has completed that ballot they will be returned to the re-
audit screen. 
 

 
4. When the audit board is confident that all choices are correct, they should click 

the Review Complete – Finish Round button.  
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Step 11-F: Concluding the Audit Round 

1. When the audit board as completed any re-audits they wish to undertake, 
the RLA Software displays the End of Round page. The audit board 
members must “sign off” by entering their first and last names, then click 
the Submit button. 
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Once all of the county’s audit boards are complete the round is over for the 

county. However, counties will not know the outcome of the audit until every 

county has completed their audit because of the statewide audit. Wait to 

hear from the voting systems team at the Secretary of State’s office for 

notification that the round is over. The notification will indicate whether the state 

as a whole requires another round or not and instructions on how to proceed. To 

check if your county contest’s risk-limit was satisfied, you must log back into the 

RLA software (see Chapter 9, Step 9-B). If both the state and county contests 

both had their risk-limit’s met the final audit report will be available to download.  

 

 

After printing the audit report, the clerk should sign and date it.  Submit the 
signed and dated audit report to the Secretary of State by email at 
rla@sos.state.co.us. 

If either the state or county risk limit was not met, a message will be 
displayed instructing the county to wait for the state to start the next round. 
Wait for notification from the state that the next round is now ready to 
proceed.  

 

For any subsequent rounds, please repeat the steps from Chapters 10 and 11. 

mailto:rla@sos.state.co.us
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APPENDIX I: OBTAINING BALLOT IMAGES FROM DEMOCRACY 

SUITE 

The steps below contain directions for how to obtain ballot images general. As an 
alternative, for obtaining single ballot images, you could navigate to the folder of the 
associated project on the NAS, open the Results folder, and then tabulator folder, batch 
ID folder, and finally locate the record (position) PDF. This can be done for each 
individual ballot. 
 
General Directions  
 

1. Log into the project in RTR. For help with this see the RTR user guide. 
2. From the top menu, select Actions. 

 

 
3. Select Export. Then select Export Audit Images. 

 

 
4. Select your filter criteria and then select Add. 
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5. Select additional filter criteria (e.g. specific contest, exception, precinct, ballot 

type, etc.) then click Export. NOTE: If you leave ‘All’ selected and do not select a 
specific item from the list, the export will include all images, sorted by that 
particular filter criteria (in Step 4). 
 

 
 

6. A confirmation message will display. Click Yes. 
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7. A progress bar will display as the images are being exported. When the process 
is complete, a confirmation message will display. Click Close to close the 
message. 
 

 
8. The exports will be saved to the project’s folder on the NAS. 

 

 


	Cover Page
	RLA Software Guide 9_22_2020

